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Disclaimer / Notes

“Preliminary” product information describes a product which is not in full production so
that full information about the product is not available yet. Therefore, acam-messelectronic
gmbh (“acam”) reserves the right to modify this product without notice. The information
provided by this data sheet is believed to be accurate and reliable. However, no
responsibility is assumed by acam for its use, nor for any infringements of patents or
other rights of third parties that may result from its use. The information is subject to
change without notice and is provided “as is” without warranty of any kind (expressed or
implied). PICOCAP® is a registered trademark of acam. All other brand and product names
in this document are trademarks or service marks of their respective owners.

Support / Contact
For a complete listing of Direct Sales, Distributor and Sales Representative contacts, visit
the acam web site at:

http: //www.acam.de/sales/distributors/

For technical support you can contact the acam support team in the headquarters in
Germany or the Distributor in your country. The contact details of acam in Germany are:

support@acam.de or by phone +49-7244-74190
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PCap Assembler

1 Assembler

The current version of the assembler is developed on the basis of PCapd1. It can be used
also for other PICOCAP devices.

Features

Platform:

\Windows 2000, XP, Vista (32-Bit), Windows-7 (32 and 64)

Type of Assembler:

Single Path Assembler

Source-File: * .asm, according to the PCapd1 assembler syntax
Target-File: Output. hex, downloadable Hex-File
Instruction: <command> [ <parameter1>, <parameter2>]

For example:

nop or adda,b or jCarC case’
Comment(s): Single line comment:

Multi line comment: <COMMENT> <ENDCOMMENT>
Includes: <command> [ <parameter1>, <parameter2>]

For example:

nop or adda, b or |jCarC case’
Constants: Constants can be defined with:

CONST myConst8 15
[The constants have to be declared before they are used for the first
time.

Number formatting:

Numbers can be written in decimal or hexadecimal notation
e.g.: load a, 16355 or load a, Ox3FE3

Jump labels:

To jump within the code, you can use jump labels together with the
various conditional jump op-codes like jed p1, JEQ p1 etc.

E.g.: jCarC label1l

label1: move a, b

Addressing:

Addressing is automatically done by the assembler. Please note that
the maximum user program size is 4kB (including all header files,
library files and calibration banks).

Subroutines:

Subroutines can be executed with the special opcode ,jsb‘ and ,jrt'.

1.1

Installing the Assembler

Insert the CD-ROM. Locate the Assembler folder and run setup.exe to install the program.

Restart the computer if required. After the installation you will find in the START menu an

item ,PCapd1 Assembler®. Run this to start the assembler program.

1-2
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1.2 Running the Assembler

In the START menu there is an item ,PCapd1 Assembler®. Run this to start the assembler

program.

1.2.1 Assembler Online Help

The following sections give just a short description of the assembler program. For a
detailed description of the assembler software please use the online help of the program.

The online help can be opened from the Menu or by pressing the F1 button.

The following help window opens up:

E? acam PCap®® Assembler Help

CEI cing
Ausblenden i Drucken  Optionen
E] Introduction
=] What's new
o @ b Ve PCAP Assembler Help n
+QAssemb!er mess-electronic

[£] License Agreement

[£] About PCAP Assembler Software
This help file is shipped as part of the PCAP Assembler Software which is provided by acam
messelectronic gmbh, Germany. The help file provides information about the software environment, the
assembler syntax and the usage of the tool. The help file contains several sections:

New with PCAP See what changes with PCAP Assembler Software.

User Interface  Contains information about the Graphical User Interface (GUI), e.g. the several available
tabs, the toolbar and the menu.

Assembler Detailed usage description of the assembler syntax and how to program your
application.

Furthermore you can find license information and general information about the software and acam here.

© 2006-2010 acam messelectronic gmbh. Germany. All rights reserved

Figure 1-1: Integrated online help of PCapd1 Assembler
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1.2.2

ZE acam PCapf® Assembler - c:\Prog

Edit View Assembler Tools He

PCap Assembler

Assembler Page

ramme\acam-messelectronic\PCapficssmmr———mmn———e s DIj

(@ E| e

RES4:
RES5:
RES6:
RES7:
RESS8:
RESS:
RES10:
RES11:

I Download l Agsembler
8 SREAGE ey

NOTE :

Author:

CONST fi

tk
tk
tk
tk

pc

DE|G&

PCapm—am | cdeinvh | medianh | rch | signed24 to_signed4gh | standardh | peapliah |

Those Llines of the firmware that have to be adapted to the sensor are marked with
" --> Adapt from Excel sheet "
OH,

=

Io
(4 @

> || Q|||

Capacitance measurement ratio with
a2 : Coefficient in polynomial for
al : Coefficient in polynomial

for
ad :

22 fd
Linearization of preskure
Linearization of pressure

Coefficient in polynomial for linearization of pressure

t&

ref [/ t_meas value from Capacitance ratio measurement

in the following source code.

VK - acam messelectronic gmbh (c) 2010

rstSignedCalValue @

signed Calibration Values Registers ( must be placed at ascending Ram-Addresses!)
-} ] ; coefficient Temperature Polynom

1 1 ; coefficient Temperature Polynom
2 2 ; coefficient Temperature Polynom
3 3 ; coefficient Temperature Polynom

32 4 coefficient Pressure Polynom A2

Compile

c:\Programme‘\acam

el — 35T

tronic\PCap@

INFO: Program Size:

successful

WARNING: configuration for program memory model not found, assuming single mode
2450 Byte
INFO: c:\Programme\acam—-messelectronic\PCapli® &

.asm: Processing was

Figure 1-2: Assembler

The ‘Assembler’ tab is

source code window

the main window to open all the source code and include files. It consists of

a status message window at the bottom and buttons to operate the assembler. By clicking the

green link labeled ,Opcode-Help (F2)° an integrated online help pops up which provides detailed

information about the available op codes.

The controls in detail:

Source code window:

1-4

This window is used as the source code and include files editor for the
assembler listings (*.asm & *.h files). This is a pure editor window;
any number of tabs can be opened in this window. This page allows the
user to display and edit any file. The files can be manually opened,
saved and closed. The location of the file displayed in the window
currently is displayed next to the ‘Compile’ button.

Additional features are line numbering, syntax highlighting and
integrated comment handling. Standard editor tasks like cut, copy &

acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de

Member of the ams Group




PCap Assembler

mess-electronic

paste or find & replace, etc. can be performed. You can modify the
settings for the editor via the tool settings dialog. To know more about
‘Include’ files and how to use them, see section 1.2.2.1 below.

Assembler button:

The assembler button to compile the source code along with the
respective header files is: Compile.

On pressing the Compile button the source file is compiled to a
downloadable hex code. If the compilation was successful a message is
displayed accordingly. If the compiling fails, an error message occurs.
If more than one source files are currently open, then the *.asm that
will be compiled on pressing the Compile Button, has the filename in
bold letters on the tab. It is the first opened .asm file in the window
that is always compiled.

Save Project button:

When a source code (*.asm] file and all the respective include (*.h)
files are open in the Assembler tab, then all the files can be combined
and saved in a project file (*.prj), by pressing the Save Project button.
The .prj file always takes the name of the *.asm file.

For e.g. A source code file sample.asm uses ‘include’ files includel.h
and include2.h. Then the corresponding prj file would be saved by the
name sample.prj. Once saved, the project file can be opened from the
menu File > Open project > *.prj file. This automatically closes all
currently open files and opens all the files (*.asm and *.h) belonging to
the project in one go. The *.prj file can also be opened and edited in
this Window.

Note1: The .asm and .h files can be in different folders or locations.
The *.prj file stores the location of the file while saving the project.

Note2: When the PCapd1 Assembler software is closed, a .prj project
file is automatically generated with all the files that are currently open
in the window. The name of this project file will be that of the open
source code file with a .prj extension. This .prj file will be used to open
all these files again when the PCapd1 Assembler software is started
again.

Open Project button:

An already saved project (with a *.prj file), can be opened using this
button

Status message window:

In this window there are the output messages of the assembler
displayed. In case the assembly process was successful, a
corresponding message appears with the path of the file that was
compiled. If an error occurs while assembling, an error message
appears together with the line number and the file name in which the
error occurred. An error in any of the source code (*.asm] file or
“include” (*.h) files is identified and intimated with the path of the file.

Opcode-Help:

Between the source code window and the status message window

acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de 1-5
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there can be found a green link labeled ,0Op code-Help (F2)'. By clicking
this link another window pops up. The window contains the op code
online help. Every supported op code is explained there in detail. The
additional windows are based on the integrated Microsoft Windows ®
Help system and can be operated separately. (Windows is a trademark
of Microsoft Corporation)

Running the assembler in order to compile your source file is the first step when using the
PCap@d1 Assembler Software.

An integrated ‘examples’ folder provides some readymade firmware code for downloading into the
PCap@d1 chip. The standard firmware (.asm and .hex) is present in the ‘standard’ folder under

‘examples’.

The user can also add his own examples to the ‘Examples’ folder with the respective prj file. The
prj file can be written manually (See format of existing prj files in the Examples folder) or can be
allowed to be generated by the assembler with the Save Project button. The Search-Examples
dialog box can be accessed via the Help menu or by pressing F4 or by clicking on the ‘Bulb’ icon
on the top. Only *.prj project files can be opened via the Search Examples option. To open

individual files, use the File - Open option.

1.2.2.1 ‘Include’ files

The basic idea of supporting ‘include’ files is to provide more modularity and flexibility
within your code. That means, instead of packing all needed source code to a single
assembler listing (*.asm files) you can roll out some pieces of code to the include files
(also called header files with extension *.h). The advantage of this method is, that the
readability of your code will be improved and that once written parts of code can be reused

(e.g. configuration information).

To include parts of code by using a include file there are two steps needed.

Step 1: Create an include file (e.g. config.h).

Step 2: Declare the inclusion in your assembler listing as follows: #include ,config.h”

Include files that are in the same folder as the source file (*.asm) can be included with
#include “filename.h”. Include files that are in a path one level higher than the source file
can be included with “../filename.h”. If there is a set of common include files, they can be

segregated in a folder called Lib in PCapO1 \Assembler\lib. The ‘include’ files in the lib

1-6 acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de
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folder can be included in the program by using #include <filename.h>. They are

automatically included from the lib folder.

On installing the assembler software, the PCapO7 \Assemblerllib is pre-installed. It
contains all the library and header files that are used in the examples. You can add your

library or header files to this folder.

The alternative method of using a single assembler files without using ‘include’ files at all is

also supported.

1.2.3 Download Page

The ‘Download’ tab displays the compiled hex code that can be downloaded into the
PCapd1 chip. The hex-file is displayed in rows with 16 bytes per row. The location of the
displayed hex file is shown at the top of the window. Now this hex file can be weritten into

the OTP or the SRAM of the PCapd1 chip for e.g. using the Evaluation software.

ﬁ acam PCap@ Assembler - c:\Programme\acam-messelectronic\PCap@*®

B¢ Q|4

Hex-File c:\Prog \ lectronic\PCapis

Flle Edit View Assembler Tools Help

Db@‘ub LJD|'ZL8—%‘ e

- apt. _pe==sm=_hex

00 00 70 BE 01 20 A2 66 67 76 77 66 42 5C 48 43
58 ED 44 84 03 27 37 20 94 Al 01 20 2F A0 01 20
2F A3 01 20 2F A4 01 20 2F A4 01 20 2F A5 D7 00
26 6D D4 43 44 D5 43 F7 44 20 45 20 5F 78 68 01
00 00 00 20 07 D5 41 7F F6 43 A9 03 6F F6 58 58
5D BF 02 42 5D 5D 42 A8 03 60 5C A9 00 70 02 7a
C0 cO cO D5 FF 43 EC 44 F4 41 2B 16 EA 45 F5 41
2B 16 E9 45 1D 41 43 58 EA 29 2D E9 50 46 EB 44
A9 02 EB 59 43 CA FE 41 5C A8 03 D3 5A EB 45 EB
41 F2 45 02 D3 43 D2 59 AA 06 75 65 7A DA 43 D2
44 02 7E 7A DA 43 D2 44 6A CO FE 43 D3 44 EF 45
5B 22 10 D8 FE 41 5D C0O FE 43 5D AB 13 47 AB 12
47 AB 11 47 AB 10 47 AB OF 47 AB OE 47 AB 0D 20
DF 22 17 22 Al 23 2B 23 B5 24 3F 24 c9 25 53 25
DD D7 FE 43 CF FE 41 D9 45 Cc0 Cc0 Cc0 c0 FF 41 ED
45 1F 41 2B 16 1F 45 D3 41 ED 53 D9 41 47 45 AA
EF 20 30 FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FP-EF FF FFEF. FF FF. FF FF:FF FF FFFF FF FFE
FF FF'FF FF FF FF FF FF FF FF 'FF FF FF FF FF FF
FF FF FF. FF FF. FFE FF FP'FF FF. FF FF FF.FF FF FF
FF FR/PE FF'FESFF FEFFP:FE FPCFR FF'FEIFF FEFE
EF. FPFSFF FF FFFE EFF FESEF FFPEF FFEFFF. FFFF
FF FF'FF FF FF FFE FF FF FF FF FF FF FF. FF FEF FF
FF FF:FE FF FF.FF. FE-FF 'FF FF: FF FF FF: FF FP FFP
FF FFP/FPP: FF 'FFP:FF FFP FF 'FF FP FF FF FFP:FF FFFF
FF FPEF FF FFEF. FF FE FF FPIFF FF FFEE FFPEFE
FF FF'FE FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FE FF. FF FF.FE FE-FF'FF FF FF. FF FF.FF. FE FF
FF FFR/PF FF'FESFF FEFP'FE FFPCFR FF'FEIFF FEFE
EF. FFEF FF FFFFE. FF FE FF. FF:EF FF - EFEFE FFFF
FF FF 'FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF:FE FF FF.FF. FE-FF 'FF FF: FF FF FF FF FP FP
FF FF FF FF FF:FF FF FF FF FF FF FF FF: FF FF 00
FF FF FF FF FF 43 02 DO C0 CO CO FF 43 D1 44 FF
— FE FO CO FF 43 C0O 44 Cc0O c0 c0 CcO FF 43 C1 44 c0

IEII AN AN AN BT AD AN AA AN AN AN A0 BT AD A AA BT M

wnload | Agsemblar
>

| Dowy

Figure 1-3: Hex-file display
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1.2.4 Assembler Settings

Different settings for the assembler and the editor can be done by selecting the item

“Settings” in the “Tools” menu. A screen appears that shows the following sheets:
Settings
Environment I Editar I

Window settings
W Alow Window Maxdmization

¥ Show hints
W Show tooltips

Lanouages:
W Automatic codepage detection at startup

" Restore default settings

Cancel
[ Clear ALL settings frequires application restart)

Figure 1-4: Environment settings

| Settings
Environment Editor I

Editor settings:
[V Show line numbenna:

V' Line numbering in gray
V' Apply syntax highlighting

[~ Enable Muttibyte Support

s :
[~ Restore default settings Aoply Cancel

[ Clear ALL settings {requires application restart)

Figure 1-5: Editor settings
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2 Miscellaneous

2.1 Literature Guide

Data Sheets

mess-electronic

Title

Document-No

PCap01-DSP
Single-chip Solution for Capacitance Measurement
Digital Signal Processor

DB_PCap01_DSP_e.pdf

PCapd2A
Single-chip Solution for Capacitance Measurement
Volume 1: General data and front-end description

DB_PCapO2A_Vol1_en.pdf

PCapd2Ax-DSP
Single-chip Solution for Capacitance Measurement
Volume 2: Digital Signal Processor

DB_PCap0O2A_Vol2_en.pdf

PCapd1-EVA-Kit
Evaluation System for PCapd1

DB_PCapO1-EVA-Kit_en.pdf

PCapd2-EVA-Kit
Evaluation System for PCapd?2

DB_PCap02-EVA-Kit_en.pdf

PCapd2plus
Evaluation Software for PICOCAP Devices

DB_PCap02plus_en.pdf

White Papers

Title

Document-No

Application Notes

Title

Document-No
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The latest versions of the available documents can be downloaded from the acam website

at:

http: //www.acam.de/download-center/picocap

2.2 Document History

16.01.2013 First release
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